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Tutorials

This section contains tutorialswhichwill showyou how to access yourAdabas orMySQLdatabase
using Portus. The tutorials are based on a number of programming languages which have built-in
Web Service support.

It also contains tutorials detailing how to set up and use the Usage Governace capability offered
by Portus.

There is a tutorial demonstrating how IBMMQSeries can be used as a transport for SOAPmessages
to Portus.

■ Adabas Tutorials
■ MySQL Tutorials
■ Usage Governance Tutorials
■ MQ Tutorial
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1 Adabas Tutorials

The Adabas tutorials are based on the well-knownAdabas 'Employees' file. The following sample
Resource definitions are put in place by the Portus server install process:

■ adabas_Employees
■ adabas_Employees_9
■ adabas_Employees_special
■ adabas_EmployeesMini
■ adabas_Vehicles

The default Adabas Database ID preset for the demo files is 212, which may not reflect the actual
Database ID in your environment, so thesewill need to be adjusted before trying to run the sample
programs. Please familiarize yourself with the Portus Control Center functions required to achieve
this before continuing the tutorials trail.

Basic Tutorials

The basic tutorials cover the following areas:

■ Using Java (Axis2) wrapper classes
■ Using the PHP SOAP Extension
■ Using Ruby
■ Using C#
■ Using soapUi
■ Using Microsoft Office : Infopath

Advanced Tutorials

Dealing with LOBs (Large OBjects)
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■ Preparing the LOB file
■ Using LOBs with soapUi
■ Using LOBs with PHP
■ Using LOBs with your favourite browser

Dealing with Transactions

■ Transactions using soapUi

Samples

This section also includes the following demo files and code samples that you can try out:

■ Tut_02_List.java
■ ex01_SoaGatewayFirst.php
■ ex02_SoaGatewayEmpList.php
■ ex02a_SoaGatewayEmpListDescending.php
■ ex02a_SoaGatewayEmpListSorted.php
■ ex06_SoaGatewaySpecial_SubDescriptor.php
■ ex06_SoaGatewaySpecial_SuperDescriptor.php
■ ex03_SoaGatewayEmpAdd.php
■ ex04_SoaGatewayEmpGet.php
■ ex05_SoaGatewayEmpDel.php
■ ex10_SoaGatewaySimpleForm.php
■ ex15_SoaGatewayUpdateForm.php
■ empMiniList.rb
■ ASGDemo.cs
■ Other Samples
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2 Using Java (Axis2) wrapper classes

Tutorial: Generate a Java wrapper for the "Employees" file

Java wrapper/stub classes are generated using the Apache Axis2 featureWSDL2Java.

If you do not have it already, download and install the latest Axis2 kit.

These are the steps required to generate the Javawrapper classes for the "adabas_EmployeesMini"
DataView supplied with Portus:

1. Create a new Java-project (refer to Getting started with Eclipse), name it "JavaEmployees"

2. Right-click the "JavaEmployees" project folder, select "Build Path", then "AddExternalArchives..:"
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Add all .jar files from the axis2 "lib" directory to the project's Build-Path.
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3. Open a command prompt (aka "DOS box"), change to the "JavaEmployees\src" directory and
run the following command

wsdl2java -uri http://<yourserver>:<yourport>/adabas_EmployeesMini?WSDL -o ..\
-p SoaG

The following items are generated from a Portus WSDL:
■ A "Stub" class implementing all types and operations ( ports / bindings )
■ A CallbackHandler - a stub class (not used in this tutorial) providing hooks for client-side
extensions to the generated result- and error handlers.

■ A Fault class

4. Add a new Java class named "Tut_02_List" to the project ( File -> New -> Class ), opt to create
a "main" method, click "Finish".
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5. Remove the generated code from the newly added class entirely, use (paste) the code from
Tut_02_List.java to create your first test program accessing ADABAS data via Portus.

6. Run the program as a "Java Application"
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7. The output appears in the "Console" window:

8. This sample selects all "Employees" records with a personnel-id of 50005nnn, you may want to
experiment varying the key data, this is easily done by modifying the properties passed to the
generated classes. E.g. try the following to list all records for "Employees" whose names start
"SMI", living in cities with names starting "D".

keys.setPersonnel_id("");

keys.setName("SMI*");

keys.setCity("D*");
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The following Java/Axis2 tutorial programs are available:

What it doesTutorial

GET a single record by Personnel IdTut_01a_Get.java

GET a single record by ISNTut_01b_GetByISN.java

LIST some recordsTut_02_List.java

SELECT by a range of Personnel IDsTut_03a_SelectSimple.java

SELECT by a range of Personnel IDs and sort by NameTut_03b_SelectSorted.java

SELECT by multiple ranges of Personnel IDs, returned in "chunks" of
20 records each

Tut_03c_SelectConversational.java

ADD + UPDATE + DELETE in "autocommit" modeTut_04a_AddUpdateDelete.java

ADD in a transactional contextTut_04b_AddTransactional.java
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3 Accessing Adabas using the PHP SOAP extension

■ What is PHP ? ................................................................................................................................ 10
■ Installing the Eclipse PHP Development Tools ....................................................................................... 23
■ Accessing Adabas from PHP ............................................................................................................. 10
■ PHP Examples ............................................................................................................................... 32
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This tutorial

■ Demonstrates how to access Portus from a PHP script
■ Provides a number of PHP examples.

What is PHP ?

PHP is a widely-used general-purpose scripting language that is especially suited for Web devel-
opment and can be embedded into HTML.

The PHP interpreter is available as source code or as pre-compiled binaries for major platforms,
including most Linux™ distributions, Windows®, Mac OS X, and iSeries™.

The latest release is PHP 5 and is seeing increasing adoption. PHP 5 introduces improvements to
the object model; also, the underlying memory management has been redesigned with multi-
threading and performance in mind.

Formore information about PHP, or to download the software, please refer to the PHPhomepage.

New in PHP 5 is a built-in SOAP extension. It is supplied as part of PHP.

For this tutorial to work, you should have PHP 5 up and running in your Web server, see the in-
stall.txt document in the PHP distribution library for details.

Installing the Eclipse PHP Development Tools

The Eclipse PHPDevelopment Tools (PDT) are not absolutely necessary, but using Eclipse greatly
simplifies the development process. This tutorial assumes the PDT to be installed.

Please refer to the Eclipse PDT project pages for installation and configuration instructions.

Accessing Adabas from PHP

1. First, create a new project within your workspace.

Tutorials10
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2. Opt to create a PHP Project, clickNext

Give the project a name and unselect the "Use default" box. Browse to the default location of
your html documents, in this case an Apache server document folder called "ASGdocs", click
Finish

11Tutorials
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If you are asked to switch to the PHP perspective, opt to do so

3. Create the PHP SOAP client

Create a PHP script file by right-clicking into the Eclipse Navigator area, selectNew -> PHP
File
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Specify a File name, click Finish
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Opt to create a "Simple PHP File"

The PHP SOAP class to represent the Adabas Service is called SoapClient, the first step will be
to instantiate SoapClient, passing the URL of an Portus WSDL as the parameter:

Now that we have instantiated our client we want to see what methods it provides and what
parameters are required. Fortunately we can get PHP and the instantiated SoapClient class to
do most of the work for us easily:

If you run this as a console application (via "Run") the output is much better formatted than
running it in the PHP browser. The console window will show the following:
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This shows that the service described by the WSDL provides five operations: list, get, delete,
add and update; It also lists the required parameters and the responses given.

A description of the input and output parameters can be retrieve by calling the __getTypes
class:

The output will look like this:

15Tutorials
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This information is sufficient to construct the first simple call to the "list" operation.

First an array of the required input parameters needs to be constructed:

Ready to invoke the "list" operation as a method of the soapclient class:

Now it is just a matter of taking the returned object and outputting the required results in a
table:

Run this in the built in PHPBrowser (activatedwith "Window" -> "Showview" and select "PHP
Browser") or an external browser: http://<your_localhost_url>/PHPempMini.php:
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PHP Examples

The following PHP examples can be copied fromhere,moved to yourweb server's DocumentRoot
(for example) and executed:

■ First steps
■ List Employees
■ List Employees descending
■ List Employees sorted
■ List by Sub Descriptor
■ List by Super Descriptor
■ Add an Employee
■ Get an Employee
■ Delete an Employee
■ A simple PHP form for accessing Adabas
■ All-in-one PHP form accessing the Employees file
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4 Accessing a Portus Resource from a Ruby program

■ Running a Ruby program .................................................................................................................. 20
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Ruby ( downloadable here) is an Open Source object oriented language with a very simple, yet
powerful SOAP interface.

Running a Ruby program

Ruby comes with a very powerful editor, SciTE, which not only allows editing, but also compiling
& execution of programs.

This is an example of a complete Ruby program listing all Employees with personnel-IDs starting
with 50005*, using the 'adabas_EmployeesMini' Resource that comes with the sample Portus
configuration.

When running this program, by either pressing the F5 key, or selecting Tools->Go from the SciTE
menu, an output windowwill be attached to the editing window, and show the result of the Ruby
query against Portus
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5 Creating a sample C# application

Tutorial: A sample C# application listing "Employees"

With a service description (WSDL), a proxy class can be created with the .NET Framework SDK
Wsdl.exe tool. A XMLWeb service client can then invoke methods of the proxy class, which
communicate with Portus over the network by processing the SOAP messages sent to and from
the Portus server. The proxy class handles the work of mapping parameters to XML elements and
then sending the SOAP message over the network.

Wsdl.exe is a Microsoft .NET tool which is used to create proxies for C#, Visual Basic .NET and
JScript .NET. In this tutorial, we will be generating C#.

These are the steps required to generate the C# wrapper class using Wsdl.exe and create / run a
program listing records from the Adabas demo file "Employees" using the generated proxy class:

1. Froma commandprompt, executeWsdl.exe, specifying theURL /URI of the PortusDataSource
to be exposed, append ?WSDL to instruct thePortus server to return the WSDL, not data:

If theWsdl.exe is not found, open the Visual Studio command prompt via the Start Menu. This
location depends on what packages are installed, but often resides under "Microsoft Visual C#
" or "Microsoft .NET Framework SDK ".
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2. A single source file is generated, its name is <rootElementName>Service.cs, in this case the "root
element" within the XSD is "adabasEmployees", thus the name of the proxy class source file
adabasEmployeesService.cs

This file contains a proxy class exposing both synchronous and asynchronousmethods for each
SOAP operation provided by Portus for the DataSource. For instance, for the list operation, the
proxy class has the following methods: list, Beginlist, and Endlist. The list method of the proxy
class is used to communicate with Portus synchronously, but the Beginlist and Endlist methods
are used to communicate with the Portus server asynchronously.

For more information about asynchronous communication with a Web Service please refer to
the .NET documentation.

3. Start MS Visual Studio, create a new project with File -> New - Project (or the shortcut
Ctrl+Shift+N):
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Create a C# Console Application, assign a name to it, specify the storage location, clickOK
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A skeleton class file has been generated into your project workspace, with the required class
definition and an emptyMainmethod
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4. First of all, import the generated proxy into the project, right-click on the project name, select
Add -> Existing Item

select the AdabasEmployeeService.cs proxy, click Add
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The proxy has been added to the project

You now need to add a reference to the .NET System.Web.Services component implementing
the SOAP interface. In the project explorer, right click on the project name, selectAddReference
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Scroll down to System.Web.Services, click to select it, click to select it, clickOK to import the
reference
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5. Remove the generated code from the newly added class entirely, use (paste) the code from
ASGDemo.cs to create your first test program accessing Adabas data via Portus.
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6. Build the application. Right-click on the project name in the project explorer, click Build

7. Open a commandwindow, change to the project's build-directory Execute the compiled console
application, EmployeesList, the output will look as follows:
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8. This sample selects all "Employees" records with a personnel-id of 4000004n, you may want to
experiment varying the key data, this is easily done by modifying the properties passed to the
generated classes. E.g. try the following to list all records for "Employees" whose names start
"SMI", living in cities with names starting "D".

keys.name = "SMI*";
keys.city = "D*;

The output will look like this:
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6 Accessing Adabas through SoapUI

This simple scenario demonstrates how to invoke operations on an Adabas DataSource exposed
as a "Web service" through Portus from SoapUI.

soapUI is a (freeware) desktop application for inspecting, invoking, developing and functional /
load / compliance testing of web services over HTTP and can be downloaded here.

Additionally, soapUI can be integrated into the Eclipse framework, readhere formore information.

1. When starting soapUI for the very first time an "empty" workspace is generated, right-click on
the top-level Projects item, selectNewWSDL Project to create your first soapUI project.
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You will be prompted for a project name, enter one and click OK:

Specify a target location for the project files, click Save:
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2. Now import an Portus "web service" into the newly created project, right-click the project name,
then select AddWSDL from URL

Enter theURI of the adabas_Employees_special resource, as in http://<yourASGserverhost>:<your-
ASGserverport>/adabas_Employees_special?WSDL and clickOK to import the webservice
definitions from the resources / WSDL
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You will be asked if default requests for all operations are to be created, click Yes.

3. Default requests have been generated for all Portus operations for a webservice, undfold the
"list" request by clicking the plus sign left of it, right-click the created Request 1, select Clone
Request, this allows for unlimited duplication of the original request, which may be desirable
when testing various options or "canning" requests.

Assign a name to the cloned request, clickOK
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4. soapUI now opens the request document.

Remove the soapenv:Header section, everything from, and including, <soapenv:Header> to
</soapenv:Header>

This leaves you with the soap Body section, which holds all key information:
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Remove all key elements but the personnel_id, enter 300000* as the key value, the request should
look like this now, then click the green arrow to send the request to your Portus server:

5. The response will look like this - formatted XML

This response shows "simple" as well as repeating fields like MUs (multiple value fields, here:
olive arrows), PEs (periodic groups, pink arrows) and MUs within PEs (blue arrows):
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7 Preparing for the LOBs (Large OBjects) samples

■ Loading the LOB file into an OpenSystems database .............................................................................. 42
■ Loading the LOB file into a Mainframe database .................................................................................... 42
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While the basic samples use the well-known 'Emplyoees' file delivered with Adabas, the LOBs
demo programs require loading of a small Adabas file containing LOB fields.

Note: LOB access requires a minimum Adabas version of v6 on OpenSystems platforms,
Adabas v8 on mainframe platforms.

Loading the LOB file into an OpenSystems database

These are the steps to load the demo LOB file into an OpenSystems (Windows, *IX) Adabas data-
base:

■ Save FILE90.FDT on the target system.
■ Save FILE90.FDU on the target system, adjust the dbid, file and lobfile parameters according
to your needs.

■ Set the environment variable FDUFDT, for example on a Linux system: export
FDUFDT=FILE90.FDT

■ Run the command: adafdu <FILE90.FDU

The demo 'base' and 'LOB' files are now loaded, which can be verified with the adarep utility:
adarep db=<yourdbid>,cont

The LOB demo file is now ready to be used.

Loading the LOB file into a Mainframe database

The steps to create the LOB demo file in a mainframe Adabas database are as follows:

■ Use this FDT as input to ADACMP, specifying dummy input (DDEBAND). Sample JCL can be
found on the ADAvrm.JOBS library distributed with Adabas.

■ Run the ADALOD utility, these parametersmay serve as template input to the utility. Adjust
the file number and size specifications based on your requirements.

Important: Note that Adabas space / buffer parameters may need to be increased for LOB
access, please consult the Adabas documentation for a description of required changes to
your Adabas nucleus parameters.
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8 Using LOBs (Large OBjects) with soapUi

This tutorial shows how to add, delete and get BLOBs using Portus and Adabas.

Portus uses theMTOM specification to send/receive the XML and binary data to/from the required
web service. This involves attaching the required binary file(s) to the SOAP message, and then
transforming this into a MIME message to send across the wire.

For the purposes of this tutorial, we will use soapUi to send and receive messages to our web
service.

Otherweb service clientsmay also be used, such as PHPwith theWSO2WebServices Framework
extension

This tutorial assumes the following

■ You have at least soapUi v1.7 installed.
■ You are using a version of Adabas which support LOBs
■ You have set up a LOB file at FNR 90.

1. Start the Control Center and add a new resource.

Enter the following information
■ Name: adabas_blobs
■ DataView : Select 'adabas_photoblobs', which is one of the sample definitions delivered with
Portus

■ DatabaseId: 212 ( or the DBID relevant on your system )
■ FileNumber: 90

Publish your changes to the server.

2. Start soapUi, and add theWSDL for the adabas_blobs service. If you are unfamiliarwith soapUi,
please run through this tutorial first
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3. You should now have a screen similar to this

Under add double-click Request 1

4. Remove the <soapenv:Header> element and all child elements.

Add the personnel_id of the record you would like the BLOB to be added

Change the cid:XYZ reference to be something familiar, for example cid:myPhoto
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5. Click the Request Attachments tab, and click Add File

Select the required LOB file and clickOpen
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When asked to Cache Attachment selectNo

6. Click the Part column, and select the CID reference you changed earlier, for examplemyPhoto

7. In the Request Properties change Enable MTOM/Inline to true
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8. Click the green arrow to send the request. The server's response will appear in the right pane
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9. Now that the record, including the LOB, has been added to your Adabas file, you will want to
retrieve it.

In Portus LOBs can be retrieved using the get request

Under get, double-click Request 1. Remove the <soapenv:Header> elements as before.

10. Add the personnel_id of the record that you wish to retrieve, for example 99880000.

Tutorials48

Using LOBs (Large OBjects) with soapUi



11. Click the green arrow, and this record will be retrieved from Adabas.

Select the Response Attachments tab, and double-click the attachment.

It should open in a web-browser, or you can save the attachment to disk by selecting Export
selected
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12. You may delete the record, including the LOB, by selecting the delete operation and entering
the corresponding personnel_id.
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9 Accessing LOBs from PHP

LOBs sent as MTOM attachments on a SOAP response from Portus can be handled by a PHP
program. This, however, requires the presence of theWSO2 Web Services Framework

Provided here are the following sample PHP programs dealing with LOBs access:

■ wsf_lobsGet: Get a record, save the LOB to a file
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10 Accessing LOBs using a browser

You can also use Portus to retrieve LOBs fromAdabas into aweb browser. This can be any browser
of your choice, for example IE running on Windows, retrieving LOBs from Adabas running on
z/OS.

In the tutorial below, we'll use the popular Firefox browser and the Portus running on z/OS.

This tutorial assumes you've already got some LOBs stored in your database. See the previous
tutorial to find out how to do this.

1. Start the Control Center and add a newWeb Service.

Enter the following information
■ Name: adabasTutorial_blobs
■ DataView : Select 'adabas_photoblobs', which is one of the sample definitions delivered with
Portus

■ DatabaseId: 212 ( or the DBID relevant on your system )
■ FileNumber: 90

Publish your changes to the server.

2. Start your browser, and enter the following URL

http://soagate:56000/adabasTutorial_blobs?GET&personnel_id=99880000

Replacing soagate:56000 with the hostname and port where Portus is running.

3. If there is a blob associated with this record, the following is returned
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4. Click on the link "Click here for blob" to display the LOB file in the browser.

Note: The LOB will open automatically in your browser, if it of a MIME type that your
browser understands. Commonly used types are PDF, WMV, JPEG, etc. Refer to your
browser documentation if you need more information.

5. Here you can see a JPEG file opened up in a new tab in firefox after the LOB link was clicked.
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11 Accessing Adabas through Microsoft InfoPath

This tutorial demonstrates how to invoke operations on an Adabas DataSource exposed as a "Web
service" through Portus from Microsoft InfoPath.

1. From the InfoPath main menu bar, select File -> Design a Form.

2. A panel will appear on your right hand side - chooseNew fromData Connection

This will start a dialog, first selectWeb Service, clickNext
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Select Receive and submit data, clickNext
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Enter the URL the WSDL for the "Employees" demo file is exposed as: http://soagate:8885/ada-
bas_Employees?WSDL

ClickNext
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Select the listmethod, clickNext
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Assign a name to the response document, clickNext
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Enter the same URL again, clickNext
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Choose list and clickNext
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Select "Entire form (XML document....", clickNext
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Assign a name to the Send Connection, click Finish
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3. You will now be presented with a form
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Do the following:
■ Enter a title "List Employees" for example
■ Expand the queryFields, drag them to the area "Drag query fields here"
■ Expand thedataFields, right-click on the adabasEmployee element.Nowdrag the adabasEm-
ployee to the area "Drag data fields here", insert it as a Repeating table

At this point, it might make sense to resize the table and the fields in the "repeating table"

4. Once you are happy with how your form looks like, select File -> Preview form -> Default
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5. Youwill be presentedwith a form, enter 4000004* in the Personnel Id field and send the request
to the server
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6. Your table will now be populated with the data based on your request:
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12 Using Transactions with soapUI

The following tutorial demonstrates howPortus can be usedwithAdabas transactions. It is assumed
you are already familiar with the following

■ soapUi ( see here )
■ Creating Portus web services from Adabas ( see here )
■ Familar with SOAP Header usage concepts ( see here )

For this tutorial, we will use the Employees demo file (usually file number 11) that comes with
Adabas, and the adabas_employees_mini_viewdata view. It is assumed you have already created
a web service for your Adabas file.

Important: By default, Portus will time-out and kill existing Conversations after a period of
time. This is can be configured using the Control Centre. with a maximum value of 3600
(10 minutes). See here for more information.

1. Import the WSDL into soapUi.

2. Choose the request for the add operation, and in the XML set the ConversationState to New
and the TransactionState to New. Also remove the other Header values. Send the request to
Portus

E.g
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Portus has now created a new Conversation and a new Transaction for this request. The IDs
for each of these are returned.

3. Verify that the record has been added successfully, (but not yet committed).

Choose a get request, remote the soapenv:Header element, and enter get the record.

E.g.
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The record has been added, but not yet committed. Because Adabas' isolation level is "Read
Uncommitted" (also known as "dirty read"), a request from a non-conversational request will
still return the added, but-yet-uncommitted, record.

4. Now backout the transaction.

Choose a get request, and enter the following:
■ ConversationState to End
■ ConversationID to the value returned in the add response
■ TransactionState to Backout
■ TransactionID to the value returned in the add response

E.g
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5. Now, if you re-run the request from Step 3, the item does not exist as the previous add has been
backed out.

E.g.
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Introduction

If Eclipse is used as the management interface to Portus then versioning of the ASG configuration
files can be achieved easily with CVS. Eclipse provides CVS interfaces, so much of the following
will be familiar to many users of Eclipse already.

UsingCVS can also bring advantages including security, auditing control, redeployment facilitation
and metadata management.

Requirements

In order to take advantage of this option, you must have available :

■ a server running CVS and to which you have access
■ a CVS 'module' where you can add the ASG related files you wish to maintain

Example Setup

■ CVS Server Details
■ CVS Module Selection
■ Selecting a Location in Eclipse
■ Adding Files to CVS
■ Making CVS aware of file changes

Select File->Import from the Eclipse Menus and then choose "Checkout Projects from CVS".
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CVS Server Details

Enter the details required for your CVS server.
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CVS Module Selection

Enter the name of the CVS module where you are to keep your ASG files, or select the module
from a list.
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Selecting a Location in Eclipse

Select where you wish to check out the CVS module to. You may place it in various locations. If
you use an existing Eclipse project, the module will appear as a folder within it. This example
creates a new Simple Project.
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The New Project is now shown in the Eclipse Package Explorer Window, the icon denoting it as
a CVS item, and the server name shown at the end.
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When you import items from ASG, you can now save them in this Project.
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Adding Files to CVS

Note that your imported files will need to be explicitly added to the CVS repository. Also note
that you will have to select the file type when adding it to CVS. This would normally be ASCII
TEXT and not the default of Binary.
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Making CVS aware of file changes

Every time you make a change to your ASG related files, you should commit those changes to the
CVS repository.
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A useful comment should be added during the commit describing the change(s) made. Ticket Id's
and other related information can be added here also.
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That should cover the basics required to use Eclipse in conjunction with CVS so that changes to
your ASG configuration files are more controlled. Further information on the use of CVS with
Eclipse, and how acquire and set-up a CVS server, can be found at the external sites listed below.

More Information

More information related to CVS can be found at http://www.nongnu.org/cvs/

More information related to CVS use with Eclipse can be found in the Eclipse documentation at
http://www.eclipse.org/
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14 Tut_02_List.java

import SoaG.*;
import SoaG.AdabasEmployeesMiniServiceStub.*;

/*
* The Portus LIST method will return all data matching the
* criteria at once, no matter how large the result set is.
*
* So if you need (or want) to retrieve the result set in "chunks"
* of records, or your request requires complex search syntax,
* use the SELECT method.
*
* Tut_03c_SelectConversational.java provides an example for this.
*/

public class Tut_02_List {

public static void main(String[] args) {

try {
AdabasEmployeesMiniServiceStub stub = new AdabasEmployeesMiniServiceStub();

AdabasEmployeeKeyType keys = new AdabasEmployeeKeyType();
keys.setPersonnel_id("50005*");

AdabasEmployeeListElement listKey = new AdabasEmployeeListElement();
listKey.setAdabasEmployeeListElement(keys);

AdabasEmployeesMiniElement result = null;

result = stub.list(listKey, null, null);

AdabasEmployeesMiniElementType root = result.getAdabasEmployeesMiniElement();
AdabasEmployeesMiniType group = root.getAdabasEmployeesMini();
AdabasEmployeeType elements[] = group.getAdabasEmployee();
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System.out.println("Number of record read: " + elements.length);

for (int i = 0; i < elements.length; i++) {
AdabasEmployeeType r = elements[i];
System.out.println("Record [" + i + "]"

+ "Personnel Id=" + r.getPersonnel_id() + ", "
+ "Name=" + r.getName() + ", "
+ "First Name=" + r.getFirst_name() + ", "
+ "City=" + r.getCity());

}

} catch (Exception ex) {
ex.printStackTrace();

}
}

}
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15 ex01_SoaGatewayFirst.php

<?php
 
/*
 *  This set of examples demonstrate the simplicity in accessing Adabas 
 *  data as "WebServices" from PHP, based on the "EmployeesMini" view
 *  representing a subset ("View") of the Adabas demo file "Employees".
 * 
 *  This first example outlines the usage of the PHP SoapClient class,
 *  which provides the infrastructure for issuing SOAP requests.
 * 
 *  All examples are based on an Adabas Portus server running on
 *  host "soagate", port 8082, these need to be adjusted to the actual
 *  server host/port used at your site.
 * 
 */
  

/*
 *  Instantiate the PHP "SoapClient" class
 */
try {
 /*
  * The only required parameter when instantiating "SoapClient" is the URL
  * pointing to the WSDL for the WebService to be accessed.
  */
 $soapclient = new SoapClient("http://localhost:8022/adabas_EmployeesMini?WSDL");
} catch (SoapFault $soapfault) {
 /*
  * In case of a SOAPFault being thrown, this will be caught and the fault
  * information printed. If a SOAPFault occurs outside of a "try/catch"
  * structure, PHP will abend the script with a generic message.
  * 
  * Here we print the SOAPFault information in a structured way, the "<pre>"
  * tags are required to format the object nicely.
  */
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 echo "<pre>";
 print_r($soapfault);
 echo "</pre>";
 return;
}

/*
 *  Without any knowledge of, or looking at Adabas definitions, a "WebService ↩
programmer"
 *  can easily retrieve the signature of any exposed Adabas Portus Service and
 *  code based on it.
 * 
 * First we use a method of the SoapClient class to retrieve the functions exposed
 * by the specific "WebService", and print it: 
 */
 
echo "<pre><B>Functions:</B>\n\n";
print_r($soapclient->__getFunctions());

/*
 *  The function prototypes shown by the __getFunction() method also depict the ↩
required
 *  parameters and the return values. Their definitions can be printed as well:
 */
echo ↩
"\n\n-------------------------------------------------------------------\n\n<B>Type ↩
Definitions:</B>\n\n";
print_r($soapclient->__getTypes());
echo "</pre>";

/*
 *  Proceed to ex02_SoaGatewayEmpList.php - List and format Employees data
 */
 
?>
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16 ex02_SoaGatewayEmpList.php

<?php

/*
 *  This example demonstrates usage of the "list" function exposed by any
 *  Adabas Portus "WebService" from PHP, retrieving selected records
 * from the Adabas demo file "Employees", and formatting it, in 4 easy steps.
 */

/*
 *  Step 1: Instantiate the PHP "SoapClient" class
 */
try {
 $soapclient = new SoapClient("http://localhost:8022/adabas_EmployeesMini?WSDL");
} catch (SoapFault $soapfault) {
 echo "<pre>";
 print_r($soapfault);
 echo "</pre>";
 return;
}

/*
 *  Step 2: Build the key ("descriptor") array, due to parser requirements ALL
 *    key elements need to be specified, but elements may be left empty
 *    when unused.
 */
$listkey = array(
 'personnel_id' => '',
 'first_name' => '',
 'name' => '',
 'city' => 'CI*');

/*
 *  Step 3: Execute the "list" request, passing the key array as the only parameter,
 *    the response object will consist of an "adabasEmployees" element containing
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 *    an array of "adabasEmployee" elements.
 */
try {
 $listresponse = $soapclient->list($listkey);
} catch (SoapFault $soapfault) {
 echo "<pre>";
 print_r($soapfault);
 echo "</pre>";
 return;
}

/*
 *  Step 4: Format the Employee records nicely into a HTML table.
 */

echo "<table border=1 cellpadding=5>";
echo "<tr><th>Personnel Id</th><th>Name</th><th>First Name</th><th>City</th><th ↩
width=200>Address Line</td>";

/*
 *  Loop through all "adabasEmployee" elements, creating a table row for every ↩
single one
 */

if ( isset($listresponse->adabasEmployees->adabasEmployee) )
{
 $Employees = $listresponse->adabasEmployees->adabasEmployee;
 if (!is_array($Employees))
  $Employees = $listresponse->adabasEmployees;

 foreach ($Employees as $Employee) {
  echo  "<tr><td>$Employee->personnel_id</td><td>$Employee->name</td><td>",
   "$Employee->first_name</td><td>$Employee->city</td><td>";
  echo "<table>";

 /*
  *  Format the "address_line" element (a MU(ltiple value field)) as a table within ↩
the table
  */
  if (!is_array($Employee->address_line)) {
   echo "<tr><td width=200>$Employee->address_line</td></tr>";
  } else {
   foreach ($Employee->address_line as $addr) {
    echo "<tr><td width=200>$addr</td></tr>";
   }
  }
 echo "</table>";
 echo "</td></tr>";
}
}
/*
 *  Proceed to ex03_SoaGatewayEmpAdd.php - Add a new employee record
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 */
?>
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17 ex02a_SoaGatewayEmpListDescending.php

<?php

/*
 *  This example demonstrates usage of the "list" function exposed by any
 *  Adabas Portus "WebService" from PHP, retrieving selected records
 * from the Adabas demo file "Employees", and formatting it, in 4 easy steps.
 */

/*
 *  Step 1: Instantiate the PHP "SoapClient" class
 */
try {
 $soapclient = new SoapClient("http://localhost:8022/adabas_EmployeesMini?WSDL");
} catch (SoapFault $soapfault) {
 echo "<pre>";
 print_r($soapfault);
 echo "</pre>";
 return;
}

/*
 *  Step 2: Build the key ("descriptor") array, due to parser requirements ALL
 *    key elements need to be specified, but elements may be left empty
 *    when unused.
 */
$listkey = array(
 'personnel_id' => '50005*',
 'first_name' => '',
 'name' => '',
 'city' => '');

/*
 *  Step 3: Execute the "list" request, passing the key array as the only parameter,
 *    the response object will consist of an "adabasEmployees" element containing
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 *    an array of "adabasEmployee" elements.
 */
try {
 $listresponse = $soapclient->list($listkey);
} catch (SoapFault $soapfault) {
 echo "<pre>";
 print_r($soapfault);
 echo "</pre>";
 return;
}

echo "List of Employees by personnel id - Ascending<br><br>";
formatResponse($listresponse);

/*
 *  Step 4: Build the SOAP Header structure to trigger a DESCENDING
 *    read instead of an ascending one.
 */

$headers = array(
 'SOAGateway_Internal_Adabas_Read_Direction' => "Descending"
 );

$header =  new SoapHeader("http://www.risaris.com/namespaces/xmiddle",
       "adabasEmployeeHeader",
                            $headers, false);

$soapclient->__setSoapHeaders(array($header));

/*
 *  Step 5: Execute the "list" request, passing the key array as the only parameter,
 *    the response object will consist of an "adabasEmployees" element containing
 *    an array of "adabasEmployee" elements.
 */
try {
 $listresponse = $soapclient->list($listkey);
} catch (SoapFault $soapfault) {
 echo "<pre>";
 print_r($soapfault);
 echo "</pre>";
 return;
}

echo "<br><hr><br>List of Employees by personnel id - Descending<br><br>";
formatResponse($listresponse);

/*
 *  Sub: Format the Employee records nicely into a HTML table.
 */
function formatResponse($listresponse){

 echo "<table border=1 cellpadding=5>";
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 echo "<tr><th>Personnel Id</th><th>Name</th><th>First Name</th><th>City</th><th ↩
width=200>Address Line</td>";

 /*
  *  Loop through all "adabasEmployee" elements, creating a table row for every ↩
single one
  */
if ( isset($listresponse->adabasEmployees->adabasEmployee) )
{
 $Employees = $listresponse->adabasEmployees->adabasEmployee;
 if (!is_array($Employees))
  $Employees = $listresponse->adabasEmployees;

 foreach ($Employees as $Employee) {
  echo ↩
"<tr><td>$Employee->personnel_id</td><td>$Employee->name</td><td>$Employee->first_name</td><td>$Employee->city</td><td>";

  echo "<table>";

  if (!is_array($Employee->address_line)) {
   echo "<tr><td width=200>$Employee->address_line</td></tr>";
  } else {
   foreach ($Employee->address_line as $addr) {
    echo "<tr><td width=200>$addr</td></tr>";
   }
  }
  echo "</table>";
  echo "</td></tr>";
 }

}

echo "</table>";
}
/*
 *  Proceed to ex03_SoaGatewayEmpAdd.php - Add a new employee record
 */
?>
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18 ex02a_SoaGatewayEmpListSorted.php

<?php

/*
 *  This example demonstrates usage of the "list" function exposed by any
 *  Adabas Portus "WebService" from PHP, retrieving selected records
 * from the Adabas demo file "Employees", and formatting it, in 4 easy steps.
 */

/*
 *  Step 1: Instantiate the PHP "SoapClient" class
 */
try {
 $soapclient = new SoapClient("http://localhost:8022/adabas_EmployeesMini?WSDL");
} catch (SoapFault $soapfault) {
 echo "<pre>";
 print_r($soapfault);
 echo "</pre>";
 return;
}

/*
 *  Step 2: Build the key ("descriptor") array, due to parser requirements ALL
 *    key elements need to be specified, but elements may be left empty
 *    when unused.
 */
$listkey = array(
 'personnel_id' => '50005*',
 'first_name' => '',
 'name' => '',
 'city' => '');

/*
 *  Step 3: Execute the "list" request, passing the key array as the only parameter,
 *    the response object will consist of an "adabasEmployees" element containing
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 *    an array of "adabasEmployee" elements.
 */
try {
 $listresponse = $soapclient->list($listkey);
} catch (SoapFault $soapfault) {
 echo "<pre>";
 print_r($soapfault);
 echo "</pre>";
 return;
}

echo "List of Employees by personnel id = 50005* - Default sort order<br><br>";
formatResponse($listresponse);

/*
 *  Step 4: Build the SOAP Header structure to trigger a DESCENDING
 *    read instead of an ascending one.
 */

$headers = array(
 'SOAGateway_Internal_Adabas_Sort_Order' => "city"
 );

$header =  new SoapHeader("http://www.risaris.com/namespaces/xmiddle",
       "adabasEmployeeHeader",
                            $headers, false);

$soapclient->__setSoapHeaders(array($header));

/*
 *  Step 5: Execute the "list" request, passing the key array as the only parameter,
 *    the response object will consist of an "adabasEmployees" element containing
 *    an array of "adabasEmployee" elements.
 */
try {
 $listresponse = $soapclient->list($listkey);
} catch (SoapFault $soapfault) {
 echo "<pre>";
 print_r($soapfault);
 echo "</pre>";
 return;
}

echo "<br><hr><br>List of Employees by personnel id = 50005* - now sorted by ↩
City<br><br>";
formatResponse($listresponse);

/*
 *  Sub: Format the Employee records nicely into a HTML table.
 */
function formatResponse($listresponse){
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 echo "<table border=1 cellpadding=5>";
 echo "<tr><th>Personnel Id</th><th>Name</th><th>First Name</th><th>City</th><th ↩
width=200>Address Line</td>";

 /*
  *  Loop through all "adabasEmployee" elements, creating a table row for every ↩
single one
  */
if ( isset($listresponse->adabasEmployees->adabasEmployee) )
{
 $Employees = $listresponse->adabasEmployees->adabasEmployee;
 if (!is_array($Employees))
  $Employees = $listresponse->adabasEmployees;

 foreach ($Employees as $Employee) {
  echo ↩
"<tr><td>$Employee->personnel_id</td><td>$Employee->name</td><td>$Employee->first_name</td><td>$Employee->city</td><td>";

  echo "<table>";

  if (!is_array($Employee->address_line)) {
   echo "<tr><td width=200>$Employee->address_line</td></tr>";
  } else {
   foreach ($Employee->address_line as $addr) {
    echo "<tr><td width=200>$addr</td></tr>";
   }
  }
  echo "</table>";
  echo "</td></tr>";
 }

}

echo "</table>";
}
/*
 *  Proceed to ex03_SoaGatewayEmpAdd.php - Add a new employee record
 */
?>
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19 ex06_SoaGatewaySpecial_SubDescriptor.php

<?php

/*
 *  This example demonstrates usage of the "list" function exposed by any
 *  Adabas Portus "WebService" from PHP, retrieving selected records
 * from the Adabas demo file "Employees", and formatting it, in 4 easy steps.
 */

/*
 *  Step 1: Instantiate the PHP "SoapClient" class
 */
try {
 $soapclient = new SoapClient("http://localhost:8022/adabas_Employees_special?WSDL");
} catch (SoapFault $soapfault) {
 echo "<pre>";
 print_r($soapfault);
 echo "</pre>";
 return;
}

/*
 *  Step 2: Build the key ("descriptor") array, due to parser requirements ALL
 *    key elements need to be specified, but elements may be left empty
 *    when unused. Here we are using the SUB-descriptor "department".
 */
$listkey = array(
        'personnel_id' => "",
        'first_name'    => "",
        'name'                  => "",
        'birthday'              => "",
        'city'                  => "",
        'dept'=> "",
        'job_title'             => "",
        'language_spoken'=>"",
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        'leave_left'    => "",
        'dept_person'   =>  "",
        'currency_salary'=> "",
        'department'    => array('dept' => "MGMT"),
        'phonetic_name' => "");

/*
 *  Step 3: Execute the "list" request, passing the key array as the only parameter,
 *    the response object will consist of an "adabasEmployees" element containing
 *    an array of "adabasEmployee" elements.
 */
try {
 $listresponse = $soapclient->list($listkey);
} catch (SoapFault $soapfault) {
 echo "<pre>";
 print_r($soapfault);
 echo "</pre>";
 return;
}

/*
 *  Step 4: Format the Employee records nicely into a HTML table.
 */

echo "Find all Employees in department group \"MGMT\" - using an Adabas ↩
SUB-Descriptor<br><br>";
echo "<table border=1 cellpadding=5>";
echo "<tr><th>Personnel Id</th><th>Name</th><th>First ↩
Name</th><th>City</th><th>Department</td>";

/*
 *  Loop through all "adabasEmployee" elements, creating a table row for every ↩
single one
 */
foreach ($listresponse->adabasDemoEmployeesSpecial->demoEmployeeSpecial as $Employee) ↩
{
 echo  "<tr><td>$Employee->personnel_id</td><td>$Employee->name</td><td>",
   
"$Employee->first_name</td><td>$Employee->city</td><td>$Employee->department_code</td>";

 echo "</td></tr>";
}

/*
 *  Proceed to ex03_SoaGatewayEmpAdd.php - Add a new employee record
 */
?>
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20 ex06_SoaGatewaySpecial_SuperDescriptor.php

<?php

/*
 *  This example demonstrates usage of the "list" function exposed by any
 *  Adabas Portus "WebService" from PHP, retrieving selected records
 * from the Adabas demo file "Employees", and formatting it, in 4 easy steps.
 */

/*
 *  Step 1: Instantiate the PHP "SoapClient" class
 */
try {
 $soapclient = new SoapClient("http://localhost:8022/adabas_Employees_special?WSDL");
} catch (SoapFault $soapfault) {
 echo "<pre>";
 print_r($soapfault);
 echo "</pre>";
 return;
}

/*
 *  Step 2: Build the key ("descriptor") array, due to parser requirements ALL
 *    key elements need to be specified, but elements may be left empty
 *    when unused. Here we are using the SUB-descriptor "department".
 */
$listkey = array(
 'personnel_id' => "",
 'first_name' => "",
 'name'   => "",
 'birthday'  => "",
 'city'   => "",
 'dept'=> "",
 'job_title'  => "",
 'language_spoken'=>"",
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 'leave_left' => "",
 'dept_person' => array('dept' => "MGMT10", 'name' => "K*"),
 'currency_salary'=> "",
 'department' => "",
 'phonetic_name' => "");

/*
 *  Step 3: Execute the "list" request, passing the key array as the only parameter,
 *    the response object will consist of an "adabasEmployees" element containing
 *    an array of "adabasEmployee" elements.
 */
try {
 $listresponse = $soapclient->list($listkey);
} catch (SoapFault $soapfault) {
 echo "<pre>";
 print_r($soapfault);
 echo "</pre>";
 return;
}

/*
 *  Step 4: Format the Employee records nicely into a HTML table.
 */

echo "Find all Employees in department group 'MGMT10' whose names start with 'K' - ↩
using an Adabas SUPER-Descriptor<br><br>";
echo "<table border=1 cellpadding=5>";
echo "<tr><th>Personnel Id</th><th>Name</th><th>First ↩
Name</th><th>City</th><th>Department</td>";

/*
 *  Loop through all "adabasEmployee" elements, creating a table row for every ↩
single one
 */
foreach ($listresponse->adabasDemoEmployeesSpecial->demoEmployeeSpecial as $Employee) ↩
{
 echo  "<tr><td>$Employee->personnel_id</td><td>$Employee->name</td><td>",
   
"$Employee->first_name</td><td>$Employee->city</td><td>$Employee->department_code</td>";

 echo "</td></tr>";
}

/*
 *  Proceed to ex03_SoaGatewayEmpAdd.php - Add a new employee record
 */
?>
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21 ex03_SoaGatewayEmpAdd.php

<?php

/*
 *  We now add a new Employee record, which is just as simple.
 */
  
try{
 $soapclient = new SoapClient("http://localhost:8022/adabas_EmployeesMini?WSDL");
} catch (SoapFault $soapfault) {
 printSoapFault($soapclient, $soapfault);
 return;
}

/*
 *  Constructing the "data record" is similar to building the key array
 *  for a "list" operation, MUs are represented by an array within the
 *  array.
 */
$adabasEmployee = array (
 'personnel_id' => '99999999',
 'first_name'  => 'Kirk',
 'name'   => 'Newlyadded',
 'city'    => 'City',
 'address_line' => array ('route 66', 'from here', 'to there', 'CA')
);

/*
 *  The expected structure is equivalent to the one returned by "list",
 *  thus we need to create an array of "adabasEmployee" elements, even
 *  though there is just one:
 */
$adabasEmployees = array($adabasEmployee);

/*
 *  Now add the Employee
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 */
try {
 $Adabasresponse = $soapclient->add($adabasEmployees);
} catch (SoapFault $soapfault) {
 printSoapFault($soapclient, $soapfault);
 return;
}

/*
 *  An "add" results in a "short response", print the message:
 */
echo "<pre>result: $Adabasresponse->results</pre>";

/*
 *  The SOAPFault is handled in a function:
 */
function printSoapFault ($soapclient, $soapfault) {
 echo "<pre>";
 echo "\n\nSoap Fault occurred\n\nFaultCode..: ↩
".$soapfault->faultcode."\nFaultString: ".$soapfault->faultstring;
 echo "</pre>"; 
}

/*
 *  Proceed to ex04_SoaGatewayEmpGet.php - Get and display the newlyadded employee ↩
record
 */
?>
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22 ex04_SoaGatewayEmpGet.php

<?php

/*
 *  The "get" operation is even easier.
 */
try{
 $soapclient = new SoapClient("http://localhost:8022/adabas_EmployeesMini?WSDL", ↩
array('trace' => 1));
} catch (SoapFault $soapfault) {
 echo "<pre>";
 print_r($soapfault);
 echo "</pre>";
}

/*
 *  Construct the "key array", which consists of just one element,
 *  the primary key for the employees file - "personnel_id";
 */
$primKey = array('personnel_id' => '99999999');

/*
 *  Get the record
 */
try {
 $Adabasresponse = $soapclient->get($primKey);
} catch (SoapFault $soapfault) { 
 echo "<pre>";
 print_r($soapfault);
 echo "</pre>";
 return;
}

/*
 *  Check if we actually got the record we are looking for
 */
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if (is_null($Adabasresponse->adabasEmployees->adabasEmployee)) {
 echo "No Employee with personnel_id=".$primKey['personnel_id'];
 return;
}

/*
 *  Print the formatted response
 */
echo "<pre>";
print_r($Adabasresponse);
echo "</pre>";

/*
 *  Proceed to ex05_SoaGatewayEmpDel.php - Delete the record added in ↩
ex03_SoaGatewayEmpAdd.php 
 */
?>
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23 ex05_SoaGatewayEmpDel.php

<?php

/*
 *  Finally we delete the Employee record with personnel_id=99999999 again
 */
 
try{
 $soapclient = new SoapClient("http://localhost:8022/adabas_EmployeesMini?WSDL", ↩
array('trace' => 1));
} catch (SoapFault $soapfault) { 
 echo "<pre>";
 print_r($soapfault);
 echo "</pre>";
}

/*
 *  All we need is the primary key
 */
$primKey = array('personnel_id' => '99999999');

/*
 *  Delete takes the key as the input and returns a "short response" (just a message)
 */
try {
 $Adabasresponse = $soapclient->delete($primKey);
} catch (SoapFault $soapfault) {
 echo "<pre>";
 print_r($soapfault);
 echo "</pre>";
 return;
}

/*
 *  Print the response
 */
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echo "<pre>";
print_r($Adabasresponse);
echo "</pre>";
?>
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24 ex10_SoaGatewaySimpleForm.php

<?php
/*
 *  On entry to the form determine if the "List Employees" button has been pressed,
 *  if this is the case, retrieve the form field values.
 */
if (isset($_POST['submit'])) {
 $Fname  = $_POST["Fname"];
 $Lname  = $_POST["Lname"];
 $Persid = $_POST["Persid"];
 $City   = $_POST["City"];
}
?>
<html> 
<head> 
<title>Personnel Info</title> 
</head> 
<body>
<font face="courier">
<form method="post" action="<?php echo $PHP_SELF;?>">
Personnel Id: <input type="text" size="8" maxlength="8"   name="Persid" value="<? ↩
echo $Persid; ?>"><br />  
First Name..: <input type="text" size="20" maxlength="20" name="Fname"  value="<? ↩
echo $Fname; ?>"><br /> 
Last Name...: <input type="text" size="20" maxlength="20" name="Lname"  value="<? ↩
echo $Lname; ?>"><br /> 
City........: <input type="text" size="20" maxlength="20" name="City"   value="<? ↩
echo $City; ?>"><br />

<br/>
<input type="submit" value="List Employees" name="submit">
</form> 
<?
/*
 *  If the "List Employees" button has been pressed, retrieve the Employees record(s) ↩
and format
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 *  them into a HTML table. The code used here is, with the exception of the ↩
variables used for
 *  building the keys array, equivalent to ex02_SoaGatewayEmpList.php
 */
if (isset($_POST['submit'])) {
 
 echo "Selected: Personnel Id=''".$Persid."'', ↩
first_name=''".$Fname."'',Name=''".$Lname;
 echo "'', City=''".$City."''<br/><br/>";

$soapclient = new SoapClient("http://localhost:8022/adabas_EmployeesMini?WSDL");

$key = array(
 'personnel_id' => $Persid,
 'first_name'  => $Fname,
 'name'   => $Lname,
 'city'   => $City
);

$result = $soapclient->list($key);

echo "<table border=1 cellpadding=5>";
echo "<tr><th>Personnel Id</th><th>Name</th><th>first Name</th><th>City</td><td ↩
width=200>Address</td></tr>";

if ( isset($result->adabasEmployees->adabasEmployee) )
{
 $Employees = $result->adabasEmployees->adabasEmployee;
 if (!is_array($Employees))
  $Employees = $result->adabasEmployees;

 foreach ($Employees as $Employee) {
  echo ↩
"<tr><td>$Employee->personnel_id</td><td>$Employee->name</td><td>$Employee->first_name</td><td>$Employee->city</td><td>";

  echo "<table>";

  if (!is_array($Employee->address_line)) {
   echo "<tr><td width=200>$Employee->address_line</td></tr>";
  } else { 
   foreach ($Employee->address_line as $addr) {
    echo "<tr><td width=200>$addr</td></tr>";
   }
  }
  echo "</table>";
  echo "</td></tr>";
 }

}

echo "</table>";
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}
?>

</body></html>
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25 ex15_SoaGatewayUpdateForm.php

<?php
/*
 *  This form incorporates ALL Adabas Portus access methods,
 *     list, get, add, update, delete
 *
 *  and demonstrates how easily web applications can be implemented
 *     based on the Adabas Portus
 */

global $PHP_SELF;

$Persid = "";
$Fname = "";
$Lname = "";
$City = "";
$Addr[0] = "";
$Addr[1] = "";
$Addr[2] = "";
$Addr[3] = "";
$msg = "";

if (isset($_POST['submit'])) {

 if ($_POST['submit'] != "Reset") {
  $Fname  = $_POST["Fname"];
  $Lname  = $_POST["Lname"];
  $Persid = $_POST["Persid"];
  $City   = $_POST["City"];
  $Addr = $_POST["Addr"];

  try {
   $soapclient = new SoapClient(
    "http://localhost:8022/adabas_EmployeesMini?WSDL");
  } catch (SoapFault $soapfault) {
   echo "<pre>";
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   print_r($soapfault);
   echo "</pre>";
   return;
  }
 }

 $msg = "";

  if ($_POST['submit'] == "Delete") {

 try {
  $Adabasresponse = $soapclient->delete(array('personnel_id' => $Persid));
 } catch (SoapFault $soapfault) {
  echo "<pre>";

  print_r($soapfault);
  echo "</pre>";
  return;
 }
 $msg = $Adabasresponse->results;
  }

  if ($_POST['submit'] == "Get") {

 try {
  $Adabasresponse = $soapclient->get(array('personnel_id' => $Persid));
 } catch (SoapFault $soapfault) {
  echo "<pre>";
  print_r($soapfault);
  echo "</pre>";
  return;
 }

 if (!isset($Adabasresponse->adabasEmployees->adabasEmployee)) {
  $msg = "No Employee with personnel_id=".$Persid;
  $Lname = "";
  $Fname = "";
  $City = "";
  $Addr = array("", "", "", "");
 } else {
  $Employee = $Adabasresponse->adabasEmployees->adabasEmployee;

  $Persid = $Employee->personnel_id;
  $Lname = $Employee->name;
  $Fname = $Employee->first_name;
  $City = $Employee->city;
  $Addr = $Employee->address_line;
 }
  }

  if (($_POST['submit'] == "Add") || ($_POST['submit'] == "Update")) {
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 $adabasEmployee = array (
  'personnel_id' => $Persid,
  'first_name'  => $Fname,
  'name'   => $Lname,
  'city'    => $City,
  'address_line' => $Addr
 );

 $adabasEmployees = array($adabasEmployee);

 if ($_POST['submit'] == "Add") {
  try {
   $Adabasresponse = $soapclient->add($adabasEmployees);
  } catch (SoapFault $soapfault) {
   echo "<pre>";
   print_r($soapfault);
   echo "</pre>";
  }
 } else {
  try {
   $Adabasresponse = $soapclient->update($adabasEmployees);
  } catch (SoapFault $soapfault) {
   echo "<pre>";
   print_r($soapfault);
   echo "</pre>";
  }
 }
  }
} else {
}
?>
<html>
<head>
<title>Personnel Info</title>

</head>
<body>
<font face="courier">
<form method="post" action="<?php echo $PHP_SELF;?>">
Personnel Id: <input type="text" size="8" maxlength="8"   name="Persid" value="<? ↩
echo $Persid; ?>"><br />
First Name..: <input type="text" size="20" maxlength="20" name="Fname"  value="<? ↩
echo $Fname; ?>"><br />
Last Name...: <input type="text" size="20" maxlength="20" name="Lname"  value="<? ↩
echo $Lname; ?>"><br />
City........: <input type="text" size="20" maxlength="20" name="City"   value="<? ↩
echo $City; ?>"><br />
Address.....: <input type="text" size="20" maxlength="20" name="Addr[]"   value="<? ↩
echo $Addr[0]; ?>"><br />
&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;.....: <input type="text" size="20" ↩
maxlength="20" name="Addr[]"   value="<? echo $Addr[1]; ?>"><br />
&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;.....: <input type="text" size="20" ↩
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maxlength="20" name="Addr[]"   value="<? echo $Addr[2]; ?>"><br />

&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;.....: <input type="text" size="20" ↩
maxlength="20" name="Addr[]"   value="<? echo $Addr[3]; ?>"><br />
<br/>
<? echo $msg; ?><br><br>
<input type="submit" value="List" name="submit">
<input type="submit" value="Get"  name="submit">
<input type="submit" value="Add" name="submit">
<input type="submit" value="Update" name="submit">
<input type="submit" value="Delete" name="submit">
<input type="submit" value="Reset" name="submit">
</form>
<?
if (isset($_POST['submit'])) {

  if ($_POST['submit'] == 'List') {
 echo "Selected: Personnel Id=''".$Persid."'', ↩
first_name=''".$Fname."'',Name=''".$Lname;
 echo "'', City=''".$City."''<br/><br/>";

 $listkey = array('personnel_id' => $Persid, 'first_name' => $Fname, 'name' => ↩
$Lname, 'city' => $City);

 try {
  $listresponse = $soapclient->list($listkey);
 } catch (SoapFault $soapfault) {
  echo "<pre>";
  print_r($soapfault);
  echo "</pre>";
  return;
 }

 echo "<table border=1 cellpadding=5>";
 echo "<tr><th>Personnel Id</th><th>Name</th><th>First Name</th><th>City</th><th ↩
width=200>Address Line</td>";

 if ( isset($listresponse->adabasEmployees->adabasEmployee) )
 {
  $Employees = $listresponse->adabasEmployees->adabasEmployee;
  if (!is_array($Employees))
   $Employees = $listresponse->adabasEmployees;
 
  foreach ($Employees as $Employee) {
   echo ↩
"<tr><td>$Employee->personnel_id</td><td>$Employee->name</td><td>$Employee->first_name</td><td>$Employee->city</td><td>";

   echo "<table>";
   if (!is_array($Employee->address_line)) {
    echo "<tr><td width=200>$Employee->address_line</td></tr>";
   } else { 
    foreach ($Employee->address_line as $addr) {
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     echo "<tr><td width=200>$addr</td></tr>";
    }
   }
   echo "</table>";
   echo "</td></tr>";
  }

 }
  }

}
?>

</body></html>
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26 empMiniList.rb (Ruby)

require 'soap/wsdlDriver'

wsdl_url = "http://soagate:8023/adabas_EmployeesMini?WSDL"

soap = SOAP::WSDLDriverFactory.new( wsdl_url ).create_rpc_driver

soap.wiredump_file_base = "soapresult"

param = {"personnel_id" => "50005*", "name" => "", "city" => ""}

result = soap.list( param )

print( "\nNumber of Employees is ", result.adabasEmployees.adabasEmployee.length, ↩
"\n\n")

for emp in (result.adabasEmployees.adabasEmployee)

  print(emp.personnel_id, ", ", emp.name, " ", emp.first_name, "\n")
  
end
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27 ASGDemo.cs

using System;
using System.Collections.Generic;
using System.Text;

namespace EmployeesList
{
    class Program
    {
        static void Main(string[] args)
        {
            adabasEmployeesService emplService;
            adabasEmployeeKeyType keys;
            adabasEmployeesElementType result;
            adabasEmployeeType[] empl;

            keys = new adabasEmployeeKeyType();
            keys.personnel_id = "300000*";

            emplService = new adabasEmployeesService();

            try
            {
                result = emplService.list(keys);
            }
            catch (SystemException ex)
            {
                Console.WriteLine("exception: " + ex.Message);
                return;
            }

            empl = result.adabasEmployees;

            if (empl.Length > 0)
            {
                Console.WriteLine("Number of Employees returned: " + empl.Length);
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            }

            for (int i = 0; i < empl.Length; i++)
            {
                Console.WriteLine("Record [" + i + "], Personnel_Id=" + ↩
empl[i].personnel_id +
                    ", Name=" + empl[i].name + ", First_Name=" + empl[i].first_name);
            }

        }
    }
}

Tutorials128

ASGDemo.cs



28 MySQL_City.cs

using System;
using System.Collections.Generic;
using System.Text;

namespace CityList
{

class Program
{

static void Main(string[] args)
{

RootElementNameService cityService;
GroupElementNameKeyType key;
RootElementNameElementType result;
GroupElementNameType[] aCity;

key = new GroupElementNameKeyType();
key.ID = "305*";

cityService = new RootElementNameService();

try
{

result = cityService.list(key);
}
catch (SystemException ex)
{

Console.WriteLine("exception: " + ex.Message);
return;

}

aCity = result.RootElementName;

if (aCity.Length > 0)
{

Console.WriteLine("Number of Cities returned: " + aCity.Length);
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}

for (int i = 0; i < aCity.Length; i++)
{

Console.WriteLine("City [" + i + "], ID=" + aCity[i].ID
+ " Name = " + aCity[i].Name
+ " CountryCode = " + aCity[i].CountryCode
+ " District = " + aCity[i].District
+ " Population = " + aCity[i].Population );

}
}

}
}
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29 FILE 90 (LOB demo file) FDT

ADACMP COMPRESS FILE=90

ADACMP FNDEF='1 , AA, 8 , A ,DE, UQ '

ADACMP FNDEF='1 , LM,32 , A ,NU '

ADACMP FNDEF='1 , LB, 0 , A ,LB, NV '
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30 FILE 90 (LOB demo file) load parameters

■ Sample load parameters for the 'base' file ........................................................................................... 134
■ Sample load parameters for the 'LOB' file ........................................................................................... 135
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Loading a LOB file involves two steps

1. loading the 'base' file

2. loading the LOB file

Sample load parameters for the 'base' file

//DDKARTE DD *

ADALOD LOAD FILE=90

ADALOD NAME=ASG-PHOTOS

ADALOD LOBFILE=91

ADALOD MAXISN=100

ADALOD DSSIZE=10B

ADALOD UISIZE=5B

ADALOD NISIZE=10B

ADALOD INDEXCOMPRESSION=YES

ADALOD ISNREUSE=YES

ADALOD LWP=1024K

ADALOD SORTSIZE=<sortsize>

ADALOD SORTDEV=<sortdev>

ADALOD TEMPSIZE=<tempsize>

ADALOD TEMPDEV=<tempdev>

/*

Tutorials134

FILE 90 (LOB demo file) load parameters



Sample load parameters for the 'LOB' file

//DDKARTE DD *

ADALOD LOAD FILE=91

ADALOD NAME=ASG-PHLOBS

ADALOD BASEFILE=90

ADALODMAXISN=100

ADALOD DSSIZE=100B

ADALOD UISIZE=5B

ADALOD NISIZE=10B

ADALOD ISNREUSE=YES

ADALOD LWP=1024K

ADALOD SORTSIZE=<sortsize>

ADALOD SORTDEV=<sortdev>

ADALOD TEMPSIZE=<temspize>

ADALOD TEMPDEV=<tempdev>

/*
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31 FILE90.FDT (LOB demo file FDT)

1 , AA, 8, A, DE, UQ ; personnel_id

1 , LM, 32, A, NU ; mime type for LOB

1 , LB, 0, A, NB,NV,LB ; LOB data
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32 FILE90.FDU (LOB demo file load parameters)

dbid = 212

file = 90

name = photos

lobfile= 91

dssize = 50b

nisize = 10b

uisize = 5b

maxisn = 100

reuse = (isn,ds)
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33 wsf_lobGet.php

Get a record from the Adabas demo file and save the LOB to a file, the extension is determined
from the mime-type stored on the file,

<?php

$id = $_GET['id'];

$reqPayloadString = <<<XML

<emp:EmployeePhotoGetElement xmlns:emp="com.SOAGateway/EmployeePhoto">

<personnel_id>$id</personnel_id>

</emp:EmployeePhotoGetElement

> XML;

try {

$client = new WSClient(

array("to"=>"http://localhost:56000/adabas_blobs",

"useMTOM"=>TRUE,

"responseXOP"=>TRUE));

$reqMessage = new WSMessage($reqPayloadString);

$resMessage = new WSMessage('');

$resMessage = $client->request($reqMessage);

printf("Response = %s \n\n", $resMessage->str);
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$cid2stringMap = $resMessage->attachments;

$cid2contentMap = $resMessage->cid2contentType;

$imageName;

if($cid2stringMap && $cid2contentMap){

foreach($cid2stringMap as $i=>$value){

$f = $cid2stringMap[$i];

$contentType = $cid2contentMap[$i];

if(strcmp($contentType,"image/pjpeg") ==0){

$imageName = "C:\\TEMP\\".$i."."."jpg";

file_put_contents($imageName, $f);

echo "<pre>File saved as ".$imageName."</pre>";

}

if(strcmp($contentType,"image/gif") ==0){

$imageName = "C:\\TEMP\\".$i."."."gif";

file_put_contents($imageName, $f);

echo "<pre>File saved as ".$imageName."</pre>";

}

if(strcmp($contentType,"audio/mpeg") ==0){

$imageName = "C:\\TEMP\\".$i."."."mp3";

file_put_contents($imageName, $f);

echo "<pre>File saved as ".$imageName."</pre>";

}

}

}else{

printf("attachments were not found ");

}
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} catch (Exception $e) {

if ($e instanceof WSFault) {

printf("Soap Fault: %s\n", $e->Reason);

} else {

printf("Message = %s\n",$e->getMessage());

}

echo "<pre>";

print_r($e);

print_r($reqMessage);

print_r($resMessage);

echo "</pre>";

}

143Tutorials

wsf_lobGet.php



144



34 Natural samples

■ NSGNATI - Portus Natural interface driver .......................................................................................... 146
■ ASGENVIN - Display natural environment .......................................................................................... 146
■ ASGECHON - Echo input ................................................................................................................ 147
■ ASGCALN - Simple calculator .......................................................................................................... 147
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The following Natural samples demonstrate the interface between Portus and the Natural pro-
gramming language

■ NSGNATI - Portus Natural interface driver
■ ASGENVIN - Display natural environment
■ ASGECHON - Echo input
■ ASGCALN - Simple calculator

NSGNATI - Portus Natural interface driver

RESET #CODE (B4)
INPUT #CODE
CALL 'XMIDNATH' #CODE
END

ASGENVIN - Display natural environment

DEFINE DATA PARAMETER
1 #NATENVOUT (A80)
1 #OSENVOUT (A80)
1 #TIMEOUT (A30)
END-DEFINE
*
COMPRESS 'NATURAL' *NATVERS 'PL' *PATCH-LEVEL

'SRVTYPE =' *SERVER-TYPE ', UI =' *UI INTO #NATENVOUT
*
COMPRESS *OS *OSVERS

'ON' *HARDWARE INTO #OSENVOUT
*
COMPRESS *DAT4I *TIME INTO #TIMEOUT
END
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ASGECHON - Echo input

DEFINE DATA PARAMETER
1 echoIn (a30)
1 echoOut (a30)
END-DEFINE
*
MOVE echoIn to echoOut
*
END

ASGCALN - Simple calculator

DEFINE DATA
PARAMETER

1 #OPERATION (A1)
1 #OPERAND-1 (I4)
1 #OPERAND-2 (I4)
1 #FUNCTION-RESULT (I4)

LOCAL
1 #WORK-RESULT (I4)

END-DEFINE
*

DECIDE ON FIRST VALUE OF #OPERATION
VALUE '+'
COMPUTE #FUNCTION-RESULT = #OPERAND-1 + #OPERAND-2

VALUE '-'
COMPUTE #FUNCTION-RESULT = #OPERAND-1 - #OPERAND-2

VALUE '*'
COMPUTE #FUNCTION-RESULT = #OPERAND-1 * #OPERAND-2

VALUE '/'
IF #OPERAND-2 NE 0 THEN

COMPUTE #FUNCTION-RESULT = #OPERAND-1 / #OPERAND-2
ELSE

MOVE 0 TO #FUNCTION-RESULT
END-IF

VALUE '%'
IF #OPERAND-2 NE 0 THEN

DIVIDE #OPERAND-1 INTO #OPERAND-2 GIVING #WORK-RESULT
REMAINDER #FUNCTION-RESULT

ELSE
MOVE 0 TO #FUNCTION-RESULT

END-IF
NONE VALUE
MOVE 0 TO #FUNCTION-RESULT

END-DECIDE
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*
END
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35 MySQL Tutorials

The MySQL tutorials are based on the World Database. This is a publically available database
which is used for MySQL testing and demonstation. You can find out more about the World
Database here

Before starting this tutorial, it is recommended you see the "Getting started with MySQL" section
here.

It is assumed that the world database has been set up and and populated as follows

It is also assumed that an ODBC System DSN called "world_dsn" has been set up as follows

Weuse the user monty to connect to our datasource, but in your instance the usermight be different.
In many cases, the root user ID is used.
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Or on Linux, assuming you are using the unixODBC driver, the following information in your
odbc.ini

[world_dsn]
Description = The world database in mysql
Driver = DriverMysql
Trace = off
TraceFile = stderr
Server = localhost
Port = 3306
Database = world
UserName =
Password =

And this information in your odbcinst.ini
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[DriverMysql]
Description = ODBC for MySQL
Driver = /usr/lib/unixODBC/libmyodbc3.so
Setup = /usr/lib/unixODBC/libodbcmyS.so
UsageCount = 1

For more information on setting up an ODBC System DSN, see this section

Finally, it assumed that the Web Service Discovery Wizard has been used to create 3 web services
based on the 3 tables in the World database.

Legacy Perspective

Administration Perspective

Now select a tutorial

■ Using C#
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36 Using C# to access MySQL

This tutorial shows how to access the "City" table in MySQL from the C# environment. It assumes
a C# environment is available, and some basic knowledge of the C# language.

With a service description (WSDL), a proxy class can be created with the .NET Framework SDK
Wsdl.exe tool. A XMLWeb service client can then invoke methods of the proxy class, which
communicate with Portus over the network by processing the SOAP messages sent to and from
Portus server. The proxy class handles the work of mapping parameters to XML elements and
then sending the SOAP message over the network. Wsdl.exe can be used to create proxies for C#,
Visual Basic .NET and JScript .NET, for the purpose, we will be generating C#. These are the steps
required to generate the C#wrapper class usingWsdl.exe and create / run a program listing records
from the City table using the generated proxy class

1. From a command prompt, execute Wsdl.exe, specifying the URL / URI of Portus Web Service
to be exposed.
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Asingle source file is generated, its name is <rootElementName>Service.cs, in this case the "root
element" within the XRD is "RootElementName", thus the name of the proxy class source file
RootElementNameService.cs

This file contains a proxy class exposing both synchronous and asynchronousmethods for each
Web Service operation provided by Portus. For instance, for the list operation, the proxy class
has the followingmethods: list, Beginlist, and Endlist. The list method of the proxy class is used
to communicate with Portus synchronously, but the Beginlist and Endlist methods are used to
communicate with Portus server asynchronously. For more information about asynchronous
communication with a Web Service please refer to the .NET documentation.

2. Start MS Visual Studio, create a new project with File -> New - Project (or the shortcut
Ctrl+Shift+N):
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Create a C# Console Application, assign a name to it, specify the storage location, clickOK
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A skeleton class file has been generated into your project workspace, with the required class
definition and an empty Main method

3. First of all, import the generated proxy into the project, right-click on the project name, select
Add Existing Item
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select the RootElementNameService.cs proxy file you created earlier, and click Add

The proxy has been added to the project

You now need to add a reference to the .NET System.Web.Services component implementing
the SOAP interface. In the project explorer, right click on the project name, selectAddReference
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Select System.Web.Services and clickOK

4. Remove the generated code from the newly added class entirely, use (paste) the code from
MySQL_CityDemo.cs to create your first C# program accessingMySQLWeb Service via Portus.
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5. Build the application. Right-click on the project name in the project explorer, click Build

6. Open a commandwindow, change to the project's build-directory Execute the compiled console
application, CityList.exe, the output will look as follows:
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7. This sample selects all Cities records with a ID of 305n, you may want to experiment varying
the key data, this is easily done by modifying the properties passed to the generated classes.
E.g. try the following to list all records for Cities whose ID start "400".

key.ID = "400*";

Or to get a list of all rows in this table:

key.ID = "*";
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37 Usage Governance Tutorials

Usage Governance can be reported in 3 ways and written to 3 output types.

■ Using the local file system
■ Using another Portus
■ Using MOM
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38 Using the local file system

Tutorial: Write Usage Governance data to the local file system

1. In the Control Centre select the server for which usage governance data will be generated.

2. Select the Governance tab in the Properties view.

To turn data collection on the Information box must be selected. If required Input Data and
Output Data may also be selected.

3. Select the Save button.

4. Stop the server.See here on how to do this.

5. Start the server.

6. Issue a request to Portus e.g. a get request.

7. Go to Portus configuration directory.

The default location of Portus configuration folder is [SERVER_INST]/Apache22/configuration
replacing [SERVER_INST] with the location in which you have installed Portus.
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8. Afile should bepresent in the format soag_usage_governance_yyyy_mm_dd_hh_mm_ss_ms.txt.
Note that it is not possible to view this file while Portus is running. Stopping the server will
create an XML file with the same name.

9. Open the file to check its contents.

10. There should be 1 entry for the get request plus all the governance data collected as per the
options selected in 2.
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39 Using another Portus

Tutorial: Writing Usage Governance data to another Portus

1. In the Control Centre select the server for which usage governance data will be generated.

2. Select the Governance tab in the Properties view.

To turn data collection on the Information box must be selected. If required Input Data and
Output Data may also be selected.

3. The Governance Server section is where we enter the details for another Portus.
■ Host : the IP address for the server.
■ Port : the port number of the server.

4. Enter these and save.

5. Stop the server. See here on how to do this.

6. Prior to restarting the server the following must be observed:
■ The Governance Server is running i.e. that Portus with the host and port number entered has
been started and is awaiting requests.
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■ The governance web service, usagegovernance, has been created successfully and is loaded.

If this has not yet been done, following the instructions here to do this.

7. Start the server. See here on how to do this.

8. On startup an initial connection is made to the governance server to verify its details. If this is
unsuccessful an appropriate error will be written to the error log so this should be checked
now.

The default location of theApache error_log is [SERVER_INST]/Apache22/logs/error_log repla-
cing [SERVER_INST] with the location in which you have installed Portus.

9. Issue a request to Portus e.g. a list request.

10. There are a couple of ways to check that the data collection has reached its destination.
■ Query the database table directly..
■ Issue a list request on the usage governance web service e.g.
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40 Using MOM

Tutorial: Write Usage Governance data to a MOM system

Usage Governance data can be written to a WebSphere MQ queue or an Software AG EntireX
server.

It is outside the scope of this tutorial to detail exactly how these are set up so it is assumed that
the chosen Messaging system is configured correctly.

In this tutorial we will be using 2 Portus servers. One will direct usage governance data collected
to a message queue and the other will read from this queue and process the input. The end result
is that the target of the usage governance web service will receive an add request complete with
the data.

1. In the Control Centre select the server for which usage governance data will be generated.

2. Select the Governance tab in the Properties view.

To turn data collection on the Information box must be selected. If required Input Data and
Output Data may also be selected.

3. The Messaging section allows one to enter the details required for None, MQ or EntireX :

Select the radio button of MQ or EntireX and fill in as appropriate for you MOM installation.
Note that the queue will be opened for output and later on in this tutorial will be opened as an
input queue.
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4. Select the Save button.

5. Stop the server. See here on how to do this.

6. Start the server.

7. At this point Portus should have connected successfully to the manager and opened the output
queue specified. Check the error log for any errors at this point.

The default location of theApache error_log is [SERVER_INST]/Apache22/logs/error_log repla-
cing [SERVER_INST] with the location in which you have installed Portus.

8. Issue a request to Portus e.g. a get request

9. An add request, containing usage governance data pertaining to this request, should appear
as an entry in the output queue.

Use a searchmechanism particular to yourmessaging system to check that this is the case. Note
the syntax of this request is supported by the usage governance web service. If the latter has
not yet been created, follow the steps outlined here to do so.

10. In the Control Centre, select the second Portus server. Open theMessaging tab in the Properties
view for the usagegovernance web service:
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11. Fill in the details for the messaging system you are using. Clearly, for MQ, the Input Q value
has to be the value specified for Queue in step 3. For EntireX the details entered here should
match those from 3.

Note: The Broker Stub value will depend on the system from which EntireX is being
called i.e. broker32.dll for Windows, broker.so for Linux etc.

12. As per the hint, switch back to Service properties and select the Save button when complete.

13. Portus will now make contact with the appropriate messaging system. Check the error log for
messages.

The default location of theApache error_log is [SERVER_INST]/Apache22/logs/error_log repla-
cing [SERVER_INST] with the location in which you have installed Portus.

14. As soon as successful connections have been made, the input queue/service will be read and
the message(s) processed.

There are a couple of ways to check the status of this.
■ Query the database table directly..
■ Issue a list request on the usage governance web service.
■ Check the Output Q (MQ) or the EntireX server for responses to the add request to the usage
governance web service.
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41 Create the usagegovernance web service

The usagegovernance web service is a bespoke service which is mandatory if usage governance
data is being collected on a separate Portus. Here are the steps required to create it.

1. In the Control Centre select the server on which usage governance data will be stored.

2. Click on the View Menu icon and select the Enable special context functions entry.

3. Under Services select the driver which will support the new service. If one has not yet been
created add one now. See here for details on this.

Right click on the driver entry and select the Create Usage Governance Service item.
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4. Fill in the details appropriate to your installation.

Select the Create database table now check box.

Select Create.

5. The web service is now created and its properties displayed .
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42 SOAP over IBM MQ Series Tutorial

Tutorial: Send SOAP requests to MQ

Portus and IBMMQSeries can be used together to enable sending SOAP requests to anMQqueue
and to receive a response from a queue. These request are asynchronous so it means that multiple
requests may be sent from the client even though Portus may not be running. These requests are
held on the queue until Portus reads and processes them. Likewise the responses will reside on a
queue until such time that a client may request them.

Here is a top level view on the steps involved.

■ For a particular web service specify the MQManager, a queue to store requests and a queue to
store responses.

■ The resultant WSDL for the web service can be read by a client which will enable it to generate
the appropriate SOAP request to send to the input queue.

■ The resultant WSDL for the web service can be read by a client which will enable it to generate
the appropriate SOAP request to read from an output queue.

Details

This tutorial will make use of Java wrapper/stub classes to access a Portus web service.

Java wrapper/stub classes are generated using the Apache Axis2 featureWSDL2Java.

If you do not have it already, download and install the latest Axis2 kit.

Theweb servicewhichwewill be using is that generated by discovering the city table in theWorld
database supplied by a MySQL installation. SeeMySQL Tutorials for details on how this is
achieved.

Ensure that the MQManager to be used has been started and that an input and output queue
created. Also ensure that a listener has been started.
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1. Select the world_dsn_city web service and open theMessaging tab. Select the MQ radio button
and tab. Fill in the details appropriate to your MQ installation.

2. As per the hint, switch back to Service properties and select the Save button when complete.

3. Portus will nowmake contact with the appropriate messaging system. If an error occurs it will
be highlighted as follows.

Check the error_log to find the cause. The default location of the Apache error_log is [SERV-
ER_INST]/Apache22/logs/error_log replacing [SERVER_INST] with the location in which you
have installed Portus. Please correct and try again.

If successful then carry on to next step.

4. Switch to the Java perspective (Window -> Open Perspective -> Other... -> Java (default). For
more information on this aspect of Eclipse see Getting started with Eclipse.

5. Create a new Java-project naming it "SOAPMQTutorial".

6. Right-click the "SOAPMQTutorial" project folder, select "Build Path", then "Add External
Archives..."

7. Add all .jar files from the axis2 "lib" directory to the project's Build-Path.

8. Right-click the "SOAPMQTutorial" project folder, select "Build Path", then "Add External
Archives..."
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9. Add all the .jar files from your MQ lib directory e.g. ..\IBM\WebSphere MQ\java\lib

10. Open a command prompt (aka "DOS box"), change to the "SOAPMQTutorial\src" directory
and run the following command:

wsdl2java -uri http://<yourserver>:<yourport>/world_dsn_city?WSDL -o ..\ -p SoaGW

11. The following items are generated from the Portus WSDL:
■ A "Stub" class implementing all types and operations ( ports / bindings ).
■ A CallbackHandler - a stub class (not used in this tutorial) providing hooks for client-side
extensions to the generated result- and error handlers.

■ A Fault class.

12. Get file SOAPEntireXTut.java and,whenprompted, save in the ..\SOAPMQTutorial\src\SoaGW
directory. Right-click on SOAPMQTutorial and select Refresh(F5). SOAPMQTut.java should
appear in the explorer window.

13. Get file mqTransports-0.1.jar and, when prompted, save it in a local directory.

14. Right-click on SOAPMQTutorial and select Build Path -> Add External Archives...
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Navigate to where mqTransports-0.1.jar was saved and select Open to add it the project.

15. Right-click on SOAPMQTut.java and select Run As -> Java Application:
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16. The output appears in the "Console" window:
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